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Before Getting Started

You can print or read this booklet in color from MicroImages’ web site.  The
web site is also your source for the newest Getting Started booklets on other
topics.  You can download an installation guide, sample data, and the latest
version of TNTmips Free.

http://www.microimages.com

Color is an important element that helps you visualize the information in geodata
that you display or print with TNTmips®.  The exercises in this booklet introduce
you to the many tools provided in TNTmips for manipulating and enhancing
image color in screen displays and for adjusting color translation to the printed
page.

Prerequisite Skills  This booklet assumes that you have completed the exercises
in the tutorial booklets entitled Displaying Geospatial Data and TNT Product
Concepts.  Those exercises introduce essential skills and basic techniques that
are not covered again here.  Please consult those booklets for any review you
need.

Sample Data  The exercises presented in this booklet use sample data that is
distributed with the TNT products.  If you do not have access to a TNT products
DVD, you can download the data from MicroImages’ web site.  In particular, this
booklet uses sample files in the COLOR data collection.

More Documentation  This booklet is intended only as an introduction to Getting
Good Color.  Details of the processes described here can be found in a variety of
tutorial booklets, Technical Guides, and Quick Guides, which are all available
from MicroImages’ web site.

TNTmips® Pro and TNTmips Free  TNTmips (the Map and Image Processing
System) comes in three versions: the professional version of TNTmips (TNTmips
Pro), the low-cost TNTmips Basic version, and the TNTmips Free version.  All
versions run exactly the same code from the TNT products DVD and have nearly
the same features.  If you did not purchase the professional version (which requires
a software license key) or TNTmips Basic, then TNTmips operates in TNTmips
Free mode.

The display color enhancement tools described here are available in all TNT
products.  Color conversion is not available in TNTedit, TNTview, or TNTatlas.
Printing using the Hardcopy Layout tools is also not available in TNTatlas.  All of
the exercises can be completed in TNTlite using the sample geodata provided.

Randall B. Smith, Ph.D., 3 September 2013
©MicroImages, Inc., 1998—2013
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Welcome to Getting Good Color
Color is an important characteristic of many raster
images, scanned maps, and other forms of spatial
data that you may work with using TNTmips.  Good
color quality makes it easier to understand and
interpret the data, both for you and for the final users
of your project results.  Achieving good color
requires subjective judgement, and in some cases
you can manipulate color to emphasize particular
features in an image.

This booklet is intended to help you enhance the
color content of images that you display on your
computer screen or print on a hardcopy output
device.  We will discuss how color is created on the
computer screen, the ways in which color
information can be stored in Project Files, and how
colors are created when you print.

To begin, let’s review two basic color models.  Both
models use sets of three primary colors that can be
mixed in varying proportions to produce a wide
spectrum of colors.  The RGB model applies when
light of different colors is mixed, as in your computer
monitor, scanner, and digital camera.  When two of
the three primary colors (red, green, and blue) are
mixed, they add together to produce intermediate
colors.  Examples are yellow (red + green), cyan
(green + blue), and magenta (blue + red).  An equal
mixture of all three additive primaries produces white
light.

The CMY model (for cyan, magenta, and yellow)
applies to color produced by mixing or overlaying
translucent inks, dyes, or glass filters.  When one of
these materials is illuminated by white light, certain
wavelengths are absorbed (subtracted from white),
and the remaining reflected wavelengths determine
the color.  Pairs of subtractive primaries can be mixed
to produce blue, red, and green.  An equal mixture
of all three yields black.  The CMY color model is
applicable to the printing process.

RGB Model

Additive mixing:
computer display

CMY Model

Subtractive mixing:
printing

The exercises on pages 4-
26 introduce you to the
manipulation of color in
screen displays.  Topics
covered include contrast
enhancement for RGB
displays, use of color
composite rasters, working
with color palettes, color
transparency for raster and
vector objects, and RGBI
display.  Page 27 is an
overview of the Raster Color
Conversion process.  Color
adjustments in the printing
process are discussed on
pages 28-37 including color
profiles, color balancing,
adjusting gamma contrast,
and printing test strips.
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STEPS
launch TNTmips
select Main / Display
from the TNTmips menu
on the Display Manager
window, choose Display
/ New / Empty 2D

Color on Your Computer Screen

NOTE: Adjusting the global
brightness and contrast
settings on your monitor has
a major effect on the
appearance of color images
on your screen, independent
of color adjustments made
in the TNTmips Display
process.

The colors on your color computer screen are
specified using the additive RGB color model.  Each
picture element (or pixel) in a desktop monitor or
laptop display is made up of separate light-emitting
elements for red, green, and blue light.  The amount
of light emitted can be varied individually for each
of the color elements making up a pixel.  In the
simplest case, with each color element either fully
on or off, this system could produce the eight basic
colors: red, green, blue, cyan, magenta, yellow, white
(all three color elements on), and black (all three
color elements off).  In reality, modern color displays
can produce 256 intensity levels for each color
element, which in varying combinations can produce
over 16 million colors.

The trio of intensity settings for each screen pixel
are stored in memory on your computer's graphics
display adapter.  Providing the full color range
described above (sometimes called “true color”)
requires 24 bits of memory per pixel (8 bits = 28 =
256 levels per color element).  Modern graphics
boards support "32-bit color", which actually means
24-bit color with an additional 8 bits representing
an alpha channel that serves as a mask for controlling
the transparency/opacity of particular image areas.

In a general sense, the RGB color model that
describes computer display colors also describes our
perception of color.  Three types of receptors in the
retina of the human eye have peak sensitivities
correseponding to these three primary colors.
However, many other physiological and
environmental factors also influence color
perception.  In addition, computer displays produce
red, green, and blue primaries that are less pure
(saturated) than those that can be perceived by
humans, so we can see a wider range (or gamut) of
colors than a monitor can produce.
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Three-Raster RGB Display
STEPS

click the Add
Raster icon
button on the Display
Manager window and
choose Red-Green-Blue
from the dropdown
menu
use the standard Select
Object window to select
rasters RED, GREEN, and
BLUE from the STHELENS

Project File in the COLOR

data collection

A color screen image can be created from several
types of raster objects or sets of raster objects.  You
have the greatest flexibility to adjust color when you
use the RGB raster display option.  Each of the three
selected raster objects is used to control the intensity
of one of the display color components.  In most
cases the component rasters will be 8-bit grayscale
objects, but you can also use 16-bit or floating-point
rasters as RGB display components.

If your input image is a scanned photograph or map,
assigning each of the red, green, and blue compo-
nent rasters to its corresponding display
channel produces a screen display that can
closely replicate the colors of the original.
However, you can also choose a set of bands
from a multispectral image source, such as
a 7-band Landsat Thematic Mapper image,
SPOT image, or multipolarization radar im-
age.  The resulting false-color images can
be used to analyze and interpret the char-
acteristics of different image areas.

The RGB raster set for this exercise repre-
sents a natural-color photograph acquired
in 1994 by the crew of NASA’s Space
Shuttle over Mount St. Helens volcano in
southwestern Washington, USA.  If your
computer is in 24-bit display mode, you will
see a true 24-bit color image.  If your com-
puter is in 16-bit or 8-bit display mode, the display
process automatically produces a reduced range of
colors that provides an optimal representation of the
24-bit color range provided by the RGB raster ob-
jects.

NOTE:  To produce valid results in the RGB display process, each component
raster must be a grayscale raster object.  This means that the order of raster
values must have some numerical significance, such as recording increasing
brightness for a measured wavelength band of light.  Categorical rasters, in
which raster values are merely arbitrary labels for different classes or groups,
should not be used as RGB display components.

The dark forested slopes in
the lower part of image
contrast with the barren, ash-
covered area devastated by
the 1980 eruption of the
volcano.
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Raster Contrast Enhancement Window
STEPS

right-click on the raster
layer's name or icon in
the Display Manager
window
choose Enhance
Contrast from the
dropdown menu
in the Raster Contrast
Enhancement window,
open the Options menu
and turn on the Envelope
option (toggle button in)
open the Options menu
again and select Input
Limits / Data Values
examine the input and
display histograms for
the Red component
(shown by default)
click the tab for the
Green component to
view its histograms
repeat for the Blue
component

You can adjust the display of each RGB component
raster individually using the Contrast Enhancement
process.  The raw values in each input raster can be
translated to a new set of display values to enhance
brightness and contrast for each band.  In RGB
display mode these individual adjustments can be
used to improve the overall brightness, contrast, and
color balance of the image.  A look-up table that maps
each input value to an adjusted brightness value can
be saved as a Contrast Table subobject for each input
raster.  The last-used table for each raster is then
used automatically by the Display process to
determine the screen display values.

When you are displaying an RGB raster set, the
Raster Contrast Enhancement window shows Input
and Display histograms for one color component at
a time.  Choose the color component you wish to
adjust by clicking the corresponding tab in the lower
part of the window.  The tabbed panel for each

component also shows the current upper and
lower limit settings for the input and output,
and includes an option button that allows
you to choose an enhancement method.

The input histogram is shown vertically
along the left edge of the window and the
display histogram horizontally across the top.
You can choose to show the display
histogram as a filled bar graph, or as a curve
(envelope).  The translation curve graphs the
function used to convert input raster values
to display values.  Some enhancement
methods allow you to directly manipulate the
shape of the translation curve.

The Method option
button on each tabbed
panel lets you choose
an enhancement method
for that display color.

Keep the Raster Contrast
Enhancement window open and
continue to the next page.

Upper limit line

Input
histogram

Translation
curve

Display
histogram



Getting Good Color

page 7

Adjust Linear Image Contrast
STEPS

click the tab for the Red
component
use the mouse cursor to
drag the upper limit line
for the Red input
histogram down until the
upper Input Limit value
is 188
click the tab for the
Green component and
change its upper input
limit to 171
repeat for the Blue
component, setting an
upper input limit of 151
click the Redraw
icon button on the
View window
choose Save All from
the File menu on the
Raster Contrast
Enhancement window
to save changes for all
three contrast tables

Each of the three raster components of the Mount
St. Helens image already has a Linear contrast table
that maps input raster values to display values using
a simple linear function.  These tables were applied
based on stored display parameters when you
displayed the image.  The image shows good color
balance, but is somewhat dark and has low contrast.

The input histograms show that most cell values in
the three rasters fall in the lower part of the 8-bit
data range, and none of them has a significant number
of cells with high values.  We can therefore improve
the image appearance by lowering the maximum
input limit for each color component.  Lowering these
limits by roughly similar amounts shifts the display
means to higher values, which brightens the image
without adversely affecting the color balance.  It also
spreads the remaining set of input values over a wider
range of display values, increasing the contrast.  Cells
with input values above the upper limit in all three
rasters display as white.  These cells correspond to
the area of snow around the summit of the
mountain, which of course should appear
white.

You can change input limits by moving
the limit lines manually, or by typing a
new value in the corresponding text box.

Keep the Raster Contrast Enhancement
window open and continue to the next
exercise.



Getting Good Color

page 8

Adjust Exponential Image Contrast
STEPS

click the tab for the Red
component and select
Exponential from the
Method option menu
use the mouse cursor to
drag the translation
curve toward the lower
right until the Power
value is 0.87
choose Save As from
the File menu and save
a new contrast table for
Red with the default
name Exponential
repeat the last two steps
for the Green
component, setting a
Power value of 0.90
click the Redraw icon
button on the Group
View window

After the contrast adjustments you made in the
previous exercise, the brighter, nonvegetated areas
in the Mount St. Helens image show good contrast.
The forested areas, however, are still somewhat dark
and lacking in detail.  We can preferentially improve
the brightness and contrast of the forested areas by
using Exponential contrast enhancement.  In this
method, display brightness is an exponential function
of the input value.  You can vary the function
graphically by manipulating the translation curve,
or enter an exponent value in the Power text field.
The default power value is 1.00, corresponding to a
simple linear enhancement.  Power values less than
1.00 increase the mean output brightness, but
preferentially increase the brightness and contrast
of the lower range of input values.  Power values
greater than 1.00 lower the mean brightness, but
preserve contrast over the upper range of input

values.

Mount St. Helens image after exponential
contrast enhancement of Red and Green.
Forested areas are brighter and have better
contrast; nonvegetated areas are more brown.

Drag the translation
curve for the Red
component to the
lower right until
the Power
value
equals
0.87.

You can also enter the desired
numerical value directly in the
Power field.
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STEPS
choose File / Close on
the Raster Contrast
Enhancement window
left-click on the
Layer Controls
icon for the raster
layer in the Display
Manager window
in the Raster Layer
Controls window Object
Panel, click on the
Contrast menu for Red,
examine the choices,
then choose Linear

Choose Contrast Options

repeat for the Green,
then click [OK]

The Contrast menus on the Raster Layer Controls
window allow you to choose contrast enhancement
options for each of the raster objects used in the
display layer.  You can choose to use one of several
automatic contrast enhancement methods, which use
default settings to stretch or compress the range of
input values to the 8-bit display range.  Your choices
are Auto Linear, Auto Normalize, Auto Equalize, Auto
Logarithmic, and Auto Exponential.  Any contrast
tables you have saved for the raster are listed at the
bottom of the menu .  In the example for this exercise
you have saved Linear and Exponential contrast
tables.

You can save different contrast tables for different
uses; you might create one contrast table that is
best for grayscale display of the single raster, and
another that is intended for use in an RGB display
with certain other raster objects.

For 8-bit rasters you can choose None from the
Contrast menu to display the raster object with no
enhancement.  (This option is not available
for 16-bit and floating-point raster objects,
as their wider numeric range needs to be
mapped to the 8-bit range via a saved or
auto contrast table for display.)  Your
choice of a contrast table or None is
automatically saved in the display
parameters stored with the raster object
so that the raster will display in the same
fashion the next time you view it.  This is
also true of your choice of color palette
(see following pages) and other display
parameters.  If the raster layer is part of a
saved group or layout, the display
parameters set up within the group or layout
are saved with those objects rather than
with the raster object itself, and are only
applied within that group or layout. Mount St. Helens image with the

selected Linear contrast.



Getting Good Color

page 10

Auto Normalize Contrast Enhancement
STEPS

right-click on the raster
layer entry in the Display
Manager and choose
Remove Layer from the
dropdown menu
click the Add
Raster icon button
on the Display Manager
window and choose
Red-Green-Blue from the
dropdown menu
select rasters RED, GREEN,
and BLUE from the
SYRDARYA Project File
open the Raster Layer
Controls window and
choose Auto Normalize
from the Contrast menu
for the Red, Green and
Blue rasters
open the Raster Contrast
Enhancement window

If no contrast table has been saved with a raster
object, and it has not been displayed previously with
the None option, then one of the auto contrast
enhancement options is automatically used to display
the raster. The method used by default is the last
auto contrast option you chose for any raster layer
in the Display process.  In other words, this default
option is global for the Display process rather than
associated with a particular raster object.  After the
raster has displayed with an auto contrast method,
you can open the Raster Contrast Enhancement
window to modify (if desired) and then save a
contrast table using that or any other contrast
method.  In order to ensure consistent display, it is
best to set up and save a contrast table for any
grayscale and RGB raster layers that you plan to use
repeatedly.

The Auto Normalize contrast method attempts to
rescale the input values to fit a normal
(symmetrical bell-shaped) distribution of
display values.  The median of the
normalized distribution is set to the middle
of the output range (128).

Space Shuttle photograph of the semiarid Syr-
Darya River region of Tajikistan, Kyrgyzstan,
and Uzbekistan, displayed with auto-normalized
contrast enhancement.  Irrigated fields of the
river valley are seen in the upper left.

Median of the
normalized output
distribution.
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Adjust Normalized Image Contrast
The auto-normalized display of the Syr-Darya shuttle
image has a hazy appearance in some areas and an
overall bluish tint.  Because the automatic contrast
enhancement methods stretch each color component
independently, they can over-stretch one or more of
the components and thus not produce an appropri-
ate color balance in the RGB display.  In this exer-
cise you reduce the brightness of the blue compo-
nent of the image and save a new set of contrast
tables.

You can change the position and shape of the
normalized display histogram by moving the vertical
dashed lines.  Moving the middle line (representing
the median brightness) to the left shifts the histogram
toward lower values, reducing the overall brightness
for that component.  You can also move the flanking
deviation lines to increase (stretch) or reduce
(compress) the contrast for the upper or lower
parts of the input range.

STEPS
click the tab for the Blue
color component
click on the middle
dashed line in the
Display histogram and
drag the line to the left
until M=100
redraw the
display in the
View window
select Save All from the
File menu on the Raster
Contrast Enhancement
window and name each
of the three new
contrast tables

The default choice on each contrast
method option menu is the method
currently used to display that color
component.

Drag the median
line of the display
histogram to the
left until the
Median value
equals 100.

Syr-Darya image after adjusting the auto-
normalized contrast for the blue color
component.
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Contrast Based on Local Area
STEPS

press the
GeoToolbox icon
button in the View
select the Polygon
tool from the
GeoToolbox toolbar
draw a polygon over the
central part of the image
as illustrated below
right-click in the View
and choose Add as
Region from the pop-up
menu
expose the Area tabbed
panel in the Raster
Contrast Enhancement
window
click on Polygon in the
list to select it
press the Apply Area
button below the list

The Area tabbed panel on the Raster Contrast
Enhancement window lets you base contrast
enhancement on any portion of the displayed image.
The selection list on this panel includes entries for
the Entire Image (the default) and any region that
has been created or selected in the GeoToolbox.
There is also an entry for each open view window,
which allows you to simply zoom in to the desired
local area.  Choosing a list entry and pressing the
Apply Area button immediately recomputes input
and display histogrmas for all image bands based
on the area selected.  If the Adjust Input Limits
toggle is turned on (the default), the Input Range
limits are also automatically adjusted to match the
ranges of the new input histograms.

Syr-Darya image with normalized
contrast based on the histograms of the
area outlined by the polygon.

The Area tabbed panel lets you
base contrast enhancement on any
portion of the displayed image.
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STEPS
in the GeoToolbox,
reselect the Polygon tool
and press the Clear icon
button
in the Raster Contrast
Enhancment window,
select Entire Image on
the Area list and press
[Apply Area]
set the Method menu on
the Red, Green and Blue
tabbed panels to
Equalize
on the Options menu,
turn off the Envelope
option
redraw the
display in the
View window

The Equalize contrast enhancement method attempts
to produce a flat output brightness histogram, with
an equal number of raster cells assigned to each
brightness level.  However, because all cells with
the same raster value must be assigned to the same
output brightness, and the input histograms of Earth
surface images tend to have an approximately
normalized shape, a completely flat output brightness
histogram usually cannot be achieved.

With the Envelope option turned off for the output
histogram, you can see in this example that the
Equalize method tends to spread the central zone of
more populated cell values over a much broader
output brightness range, while the less populated cell
values at the high and low ends are compressed
together at the extremes of the display brightness
range.  The resulting image shows crisp though
somewhat harsh contrast in comparison to the
Normalize method.

Syr-Darya image with equalized
contrast enhancement. Raster Contrast Enhancement window with

Envelope option turned off for Equalize method.

The Options menu also lets
you choose to show the
histograms with either linear
scaling (the default) or
logarithmic scaling.

The translation
curve is not
adjustable in the
Equalize method.

Equalize Contrast Method
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Hyperbolic Tangent Contrast Method
The Hyperbolic Tangent contrast enhancement
method uses the hyperbolic tangent trigonometric
function to produce a nonlinear translation of raster
values to display values.  This method is supplied
with an adjustable scale parameter that you can use
to fine-tune the amount of contrast enhancement.
At low values of the Scale factor (less than 1) the
translation curve is close to linear (see the curve set
for the Blue band in this exercise).  As the scale
factor is increased, the translation curve flattens in
the middle and steepens at either end (see the Green
and Red translations curves).  As a result, the
midrange portion of the display histogram is
stretched at the expense of both high and low values,
increasing image contrast for midrange values
without greatly shifting the mean brightness. You
can adjust the input range limits along with the scale
factor to modify brightness and constrast.

STEPS
set the Method menu on
the Red, Green and Blue
tabbed panels to
Hyperbolic Tangent
on the Red tab, set the
Input Range upper limit
to 187 and the Scale
value to 3.0
on the Green tab, set
the Input Range upper
limit to 147 and the Scale
value to 2.0
on the Blue tab, set the
Input Range upper limit
to 131 and the Scale
value to 1.0
redraw the
display in the
View window
remove the RGB layer
when you have
completed this exercise

Syr-Darya image with hyperbolic
tangent contrast enhancement.

Hyperbolic tangent contrast settings for the
Red band, with scale factor set to 3.0 to
stretch the midrange display brightness.
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You should be able to create adequate
contrast enhancement for most raster images
using one or more of the enhancement
methods described previously.  Which
method works best for a particular image
depends upon the nature and variety of
surface materials in the image, the parameters
used in acquiring and processing the image,
and how you intend to use it.  You should
experiment with different methods to find the
one that produces the best brightness and
contrast for each image.

The remaining two contrast enhancement
methods, Logarithmic and User Drawn, are
special-purpose methods.  The Logarithmic
method provides a  translation curve in which
the output brightness is a function of the
logarithm of the input raster value.  The
translation curve is not adjustable (except for
setting lower and upper limits).  This method
is most useful for images with a high
proportion of low values, which is common
in images from imaging radar systems.
However, a logarithmic translation can also
be set up using the Exponential method, in
which you can vary both the limits and the
power (exponent) to provide fine adjustments
to the enhancement.

In the User Drawn method you can freely
adjust the shape of the translation curve in
two ways. You can use the mouse to redraw
the translation curve itself, or to redraw the
shape of the output histogram.  You can use
this method to selectively stretch some parts
of the input range while compressing others
to achieve special effects in the displayed
image.

Other Contrast Methods

Logarithmic enhancement curve.

An example of a User-Drawn
enhancement translation curve.
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STEPS
choose Single
from the Add
Raster icon button menu
select raster object
COMP24 from the COLOR

Project File
place the cursor over
any part of the displayed
image until the DataTip
appears, and note the
values
remove the COMP24
raster layer
repeat the first two
steps, selecting the
COMP16 object from the
COLOR Project File

Color information can also be stored in a single
composite color raster object.  TNTmips supports
several types of composite color objects.  The first
object used in this exercise is a 24-bit color
composite, which can reproduce any color created
by an RGB display of three 8-bit raster objects.  A
24-bit composite raster stores three values for each
cell  (one for each display color), with an 8-bit data
range for each value.  A 16-bit composite raster has
a similar three-value format, but uses only a 5-bit
data range (32 brightness values) for each display
color, and so can represent over 32,000 separate
colors.  You will probably see no discernible loss in
color quality between the 24-bit and 16-bit composite
versions of most images.

When you display a three-value-per-cell composite
color object, you can adjust and save the contrast
for the three color components using the Raster
Contrast Enhancement window in the same way as
for a three-raster RGB image display.

Single-Raster Composite Color

NASA Space Shuttle photograph of Alexandria, on the
Mediterranean coast of Egypt.  The green vegetation of
the Nile River delta in the lower right contrasts with the
barren sands of the Western Desert in the lower left.

24-bit and 16-bit
composite color
rasters store
separate Red,
Green, and Blue
values for each
raster cell.

remove the COMP16 layer
when you have
completed this exercise
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Composite Color with Color Palette
STEPS

choose Single
from the Add
Raster icon button menu
select raster object
COMP8 from the COLOR

Project File
select Edit Colors from
the raster layer's right
mouse button menu
after you have examined
the color palette, select
Close from the File menu

Natural color image of South America
from data acquired by the SeaWiFS
satellite.  The most cloud-free parts of
images acquired over a 15-day period
(18 September to 3 October 1997) were
assembled to produce the final image.

The Color Palette Editor window shows the
color assigned to each possible raster value,
from 0 in the upper left to 255 in the lower
right.  (Raster values increment from left to
right in each row of the sample array).

A final option for color composite images is an 8-bit
composite-color raster.  This type of raster object
can include up to 256 unique colors.  The numeric
values in the raster are arbitrary, and serve merely to
assign display colors from a color palette (or color
map) stored as a subobject of the raster.  The color
palette records a set of RGB values for each of the
raster values in the 8-bit data range (0 to 255).  A
color map subobject is created automatically when
you import an 8-bit color composite image, or when
you use the Color Conversion process to create an
8-bit composite color raster from an RGB raster set
or 24- or 16-bit composite raster.

The Color Palette Editor displays the array of as-
signed colors for the current composite raster object.
Assignment of colors to particular raster val-
ues is arbitrary in this case, so there is no
obvious order to the color palette for a com-
posite color raster.  Likewise, displaying the
raster without the color map does not pro-
duce a meaningful grayscale image.

Raster value 0 Raster value 255

remove the COMP8 layer
when you have
completed this exercise
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Grayscale Raster with Color Palette
STEPS

choose Single
from the Add
Raster icon button menu
select raster object
DEM16 from the COLOR

Project File
open the Raster Layer
Controls window and
make sure that
ColorMap is selected in
the Color Palette option
menu

A color palette can also be used to create a
pseudocolor display from a grayscale raster object.
When the raster values represent a smoothly varying
surface, you can use a color palette with a similarly
smooth gradation of colors to emphasize the
characteristics of the surface.  A color palette can be
used with any type of grayscale raster object, but no
more than 256 colors can be included in the palette.
When you use a color palette with a 16-bit or
floating-point raster object, the display process
automatically partitions the range of raster values
into 256 bins for purposes of color assignment.  If
you select a contrast option other than None, the
contrast enhancement is applied before the color
assignments are made from the color palette.  You
can use the Color Palette menu on the Raster Layer
Controls window to choose any color palette that
has been saved as a subobject of the raster (or None
to view the raster without any palette).

Digital elevation model of Mount St. Helens,
Washington.  The color palette portrays low
elevations in green, grades up through yellow
to brown, and shows the mountain summit in
very light gray.

Portion of the DEM (a
16-bit raster) displayed
without the color
palette.  Displaying the
DEM with the color
palette creates a more
lively and interesting
display and brings out
more detail.

press the Edit button
next to the Color Palette
menu

Keep the Color Palette Editor window
open and continue to the next page.
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Using Standard Color Palettes
STEPS

choose Rainbow1 from
the Palette menu in the
Color Palette Editor; if
that selection is not on
the menu, choose More
Palettes to open a dialog
to select it

Mount St. Helens DEM displayed with
the Rainbow1 color palette.

Random color palette.

Standard Red Linear color palette.

Standard Rainbow 1 color palette.

The Color Palette Editor provides a number of
standard color palettes that can be selected from the
Palette menu for use with any grayscale raster object.
For example, the Rainbow1 palette mimics the range
of colors in a rainbow, from purple (index 0) through
blue, green, yellow, red, and pink (index 255).  The
Gray, Red, Green, and Blue Scale palettes each have
index 0 set to black, then progress through increasing
levels of the respective color.  The Random color
palette has colors assigned randomly to the palette
index values.

You can edit any standard palette to create a new
color palette.  After editing, you can choose Save As
from the File menu to save the new palette as a
subobject of the current raster.  Alternatively, you
can use the Save As option on the Palette
menu to save the new palette as a standard
palette. The new palette is added to the
Palette menu, and so becomes available for
use with any raster object.

click the Redraw
icon button on the
View window

Keep the Color Palette Editor window
open and continue to the next page.
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Editing Palette Colors
You can edit any color in the color palette by clicking
on its sample (tile) in the palette array and using the
sliders on the RGB tabbed panel to change its Red,
Green, and Blue values.  (Sliders that let you set
values in the HIS, HBS, CMY, and CMYK color
systems are found on their respective tabbed panels).
The X symbol marks the selected tile in the palette
array; a larger color sample and the index number
of the selected tile are shown below the palette.  The
0 index color is selected by default when the Color
Palette Editor window opens.

You can manually select a range of color tiles by
first selecting one tile, then holding down the Shift
key while clicking on another tile; the entire range
of tiles in between is then also selected.   An icon
button is also provided to automatically select a range
of colors similar to the currently selected tile.  When
you have selected a range of tiles, any color changes
you make are applied to all of the selected tiles.  The
Copy and Paste icon buttons allow you to quickly

transfer a color from one tile to one or more
other tiles.

STEPS
click on a color tile in the
color palette array; note
the X symbol that
appears in the tile and
the new value that
appears in the Index
numeric field
click on the color tile in
the upper left corner of
the array (0 index)
hold down the Shift key,
then click on the tile in
the upper right corner of
the array (index 31)
move the Green slider to
set its value to 50
(changing all the
selected tile colors)
click the Copy
icon button
click on the lower
left color tile (index 224)
and press the
Paste icon button

Holding down the Shift key while clicking
on a color tile selects the entire color
range from the tile selected previously (in
this case, index 0) to the new tile (31).

Keep the Color Palette Editor window
open and continue to the next page.

Copy Paste Select Similar Colors

Palette after editing range of tiles.

Palette after copy and paste
operations.
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click on the Spread tab
in the Color Palette
Editor, then click on the
Mode option button to
reveal the selection of
available color spread
models

Color Spaces and Color Spreads
You can create your own smooth color gradations
by applying a color spread to all or part of the
palette.  You first assign a color for the low and high
ends of the selected value range, then select a color
spread mode.  Applying the spread then creates a
gradual color variation across the range of
intervening values.

Several color spread modes are available.  Each
mode uses a particular color model to represent
ranges of colors.  These color models are most eas-
ily understood if they are represented graphically as
three-dimensional color spaces.

Black

White

Saturation

Hue

R

Y

MB

C

G

The RGB color model represents colors within
a cubic volume defined by orthogonal Red,
Green, and Blue axes.  Black is at the origin of
the coordinate system (R=G=B=0), and white
is at the opposite corner of the cube
(R=G=B=255).  The diagonal connecting the
black and white corners (gray dashed line)
contains the range of neutral gray levels.
Complementary colors (such as blue and yellow)
lie at opposite corners of the cube.  An R-G-B
color spread includes colors found on a straight
line connecting the two end-member colors (for
example, the edge connecting red and yellow).

HIS
Color
Space

The Hue-Intensity-Saturation (HIS) color model
represents colors within a double-cone space.  The vertical
axis is intensity, which represents variations in the
lightness and darkness of a color.  The 0 intensity level
is black; full intensity is white.  HIS values elsewhere
along the intensity axis represent different levels of
gray. On any horizontal slice through the model space,
the hue (or “color” of the color) varies around the slice,
and the saturation (the purity of the color) increases
radially outward from the central intensity axis.
Maximum saturation in this model is at the midpoint of
the intensity range.  (The closely-related HBS model uses
a single-cone color space with maximum saturation at
full brightness.)  You can apply an HIS spread in either the
clockwise (CW) or counterclockwise (CCW) directions
around the cone.  (The directions are defined in terms of a
view upward along the intensity axis; the arrow shows the
counterclockwise direction).
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Creating a Color Spread
STEPS

choose Grayscale
(linear) from the Palette
menu
on the RGB panel, move
the Red slider to 40 and
the Green slider to 20
click on the color sample
for 255, and move the
Red and Green sliders
to 95
on the Spread panel,
select HBS CW from the
Mode option menu
press [Apply Spread]
close the Color Palette
Editor window

Now let’s try creating a clockwise HBS color spread
from brown (for the 0 palette index) to bluish-white
(for 255). This produces a smooth gradation from
brown to green, light blue, to near-white.

You can use the Set buttons on the
Spread panel to designate any selected
palette index as the start or end of a color
spread (0 and 255 are the default values).

Use the Red
and Green
sliders to
change the
color for palette
index 0 to
brown.  The
color tile next to
the Index field
shows the color
for the current
index value.

Lower part of the Mount St. Helens DEM
with the new color spread applied.

Color palette after pressing Apply Spread.

when you have completed this exercise,
open the Raster Layer Controls window
and choose ColorMap from the Color
Palette menu and press [OK]
choose Display / Close on the Display
Manager

After you apply the
spread you can
choose Save As from
the File menu to save
the new color palette
as a subobject of the
current raster object.

You can design complex color palettes
(such as the initial ColorMap palette for
the DEM16 raster) by specifying a number
of intermediate colors, then creating color
spreads between them.
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Using Raster Transparency
STEPS

press the Open
icon button on the
Display Manager and
select DEMGROUP from the
COLOR Project File
click on the Layer
Controls icon
button for the DEM16
layer in the Display
Manager
in the Raster Layer
Controls window click on
the Options tabbed panel
enter 40 in the
Transparency field and
press [Apply]
set a Transparency level
of 70 and press [Apply]
set the Transparency
level back to 0 and press
[OK] on the Raster Layer
Controls window before
proceeding to the next
exercise

Mount St. Helens DEM with color palette from previous page, displayed with different
transparency levels over a shaded-relief raster: left, 40% transparency; right, 70%.

You can create interesting visual effects by setting a
raster layer to be partially transparent so that its
image blends visually with any layers below it in the
display group.  One common application of this
technique visually blends a DEM displayed with a
color palette and a shaded relief image of the DEM
(created in the Topographic Properties process in
TNTmips) to create a color shaded relief view.  The
Transparency field on the Options panel of the Raster
Layer Controls window sets the same tranparency
level for all cells in the raster.  You can set the

Transparency
percentage to
any integer
value from 0
( c o m p l e t e l y

opaque) to 100 (completely transparent).  You can
also use a separate toggle on the Options panel to
have any null cells in the raster rendered completely
transparent.
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Using Transparency in Color Palettes
STEPS

right-click on the DEM16
layer entry in the Display
Manager and choose
Edit Colors from the
dropdown menu
In the Color Palette
Editor, enter 10 in the
Transparency field for
the color tile in the upper
left corner (Index 0)
click on the tile in the
lower right corner (index
255) and enter 90 in the
Transparency field
on the Spread tabbed
panel, press [Apply
Spread]
redraw the
display in the
View window

close the Color Palette Editor window and close the current group when you have
completed this exercise (answer No when you are asked whether to save changes).

Palette with transparency values set
for the 0 and 255 index colors (each
marked by a cross symbol).

Palette with spread applied to create
gradually varying transparency values.

Mount St. Helens DEM with color palette
transparency varying from 10% for brown
color at lowest elevation to 90% for white
at the highest elevation.

You also have control of raster transparency at the
level of individual colors in a color palette.  Use the
Transparency field in the Color Palette Editor
window to set a transparency percentage for the
currently selected color tile (or set of tiles).  When
you apply a color spread to a range with transparency
set for one or both ends of the range, gradually
varying transparency values are applied across the
entire range.  In this exercise you reapply the HBS
CW color spread used to create the original palette,
but with transparency values set for the bottom and
top of the range.  This action doesn't alter the colors
in the palette; instead it applies a gradual increase in
transparency from the 0 index color to the 255 index
color.
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Vector Polygon Fill Transparency
Solid color fill styles that you create for vector or
CAD polygons or for TIN triangles also can be dis-
played with varying degrees of transparency.  The
object with transparent fills can then be displayed
over another object (such as a raster image) and the
information conveyed by both layers is easily vis-
ible.  Once you have set a transparency value as part
of the definition of a fill style, the transparency ef-
fect is used automatically whenever the object is
displayed using that style in a 2D or 3D view.  For
more information on vector display styles, consult
the tutorial booklet entitled Creating and Using
Styles.  Transparency effects for all types of spatial

objects are also
applied auto-
matically when
you print lay-
outs.

Shading raster created from the Mount
St. Helens DEM overlaid by a vector
hazard zonation map.  The polygon fills
are solid colors with 75% transparency,
so the underlying terrain remains visible.

STEPS
choose Display / Open
from the Display
Manager and select
HAZGROUP from the COLOR

Project File
click the Layer
Controls icon
button for the HazZones
layer in the Display
Manager
click the Polygons tab in
the Vector Layer
Controls window,  then
click the Edit button next
to the Style menu
on the Assign Styles by
Attribute window that
opens, press [Edit
Styles...]

click [OK] to close the Style Editor, the
Assign Styles by Attribute window,
and Vector Layer Controls window,
then close the current group

You can set a Transparency percentage for
solid polygon fills in the Style Editor window
(0% = completely opaque fill, while 100% =
fully transparent = no color fill).
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RGBI Raster Display

Part of RGB display of objects TM5R,
TM4R, and TM3R.  (These objects were
produced by resampling to the 10-m
cell size and extent of the SPOT
panchromatic image.)

RGBI display of the same three TM rasters
with object SPOTPAN as Intensity.  The
resulting display combines the high spatial
resolution of the SPOT panchromatic image
with the spectral content of the TM bands.

The RGBI raster display mode uses four raster
objects to produce an enhanced color display.  The
rasters selected as Red, Green and Blue components
provide color information that is then combined with
the Intensity raster for display.  You can choose from
several color blending modes, including HIS, HBS,
Ratio, and Brovey.

All selected objects must have the same cell size
and extents.  This means that if you want to visually
combine color and Intensity images with different
cell size (such as pan-sharpening multispectral
satellite image bands with a higher-resolution
panchromatic band), you must first resample the
color component rasters (using the Raster
Resampling process: Raster / Resample and
Reproject / Automatic) to match the extents and cell
size of the Intensity raster before using them for
RGBI display.  See the tutorial booklet entitled
Rectifying Images for more information about
resampling.

STEPS
click the Add
Raster icon
button on the Display
Manager toolbar and
choose Red-Green-Blue-
Intensity from the
dropdown menu
from the RGBI Project File,
select raster object TM5R

for Red, TM4R for Green,
TM3R for Blue, and
SPOTPAN for Intensity
click on the Layer
Controls icon for
the raster layer in
the Display Manager
on the Options tabbed
panel of the Raster Layer
Controls window, choose
HIS from the Color
Blending Mode menu,
then press [OK]
close the display group
when you have
completed this exercise

NOTE: You can use the Multiresolution Fusion process to permanently pan-sharpen
multispectral image bands.  See the tutorial Combining Rasters for more information.
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Color Conversion Process
STEPS

choose Image / Combine
/ Convert Color from the
TNTmips menu
on the Raster Color
Conversions window,
select RGB Separate
from the Input Type
menu
click [Select Raster(s)...]
and select rasters RED,
GREEN, and BLUE from the
STHELENS Project File
choose Exponential from
the Contrast menu for
each of these input
rasters
select Composite 24-bit
from the Type menu
select Average from the
Pyramid menu
press [Run]
use the standard Select
Object window to save
the output raster object
in the same Project File
display the saved
composite raster object

24-bit composite color raster
created from RED, GREEN, and BLUE.

The Color Conversion process allows you to change
the storage mode or color space of a color image.
You can convert from or to a single color composite
raster, an RGB raster set, or Hue-Intensity-Saturation
(or related variant) raster set.  With RGB input rasters
you can select contrast tables or automatic contrast
enhancements to be applied during conversion.

When you have an RGB image that is dark but has
good color balance, conversion to the HIS color
space can provide an easy means of enhancing the
color.  You can display the output Intensity raster,
adjust its brightness and contrast, and select the
resulting contrast table for use during the
reconversion from HIS to RGB.  The resulting RGB
raster set will show improved brightness and contrast
while retaining its original hues.

click Exit to close the Raster Color
Conversions window
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In a Dither about Printing

Highly magnified portion of
the Alexandria Space
Shuttle photo.  A 24-bit color
image includes very subtle
cell-to-cell color variations.

Same area dithered for printing.  At this layout scale,
each input raster cell is represented by a 5 x 5 array of
printer dots.  The dithering process uses different
patterns of the available print colors to recreate the
wide range of colors in the original image.

Now that we have covered the basics of producing
good colors when displaying images, we turn to the
realm of printing color images.  Let’s begin by
considering how printers reproduce colors.  Most
digital printers apply tiny dots of cyan, magenta,
yellow, and black ink to the page.  For most common
printers (such as ink-jet and solid-ink types), these
dots have a fixed size, and each ink color is either
fully “on” or fully “off” for each dot.  By overlaying
the translucent inks on a single dot, these printers
can also produce blue, green, and red dots.  If no ink
is applied for a dot position, it remains white.

Printers use these eight basic colors (or more, plus
black) to simulate a much wider range of image col-
ors.  This is possible because of the printer’s high
spatial resolution.  In other words, the ink dots are
very tiny and very close together, which has two im-
portant consequences.  First, a single image pixel is
commonly represented by an array of ink dots.  Sec-
ond, we can’t distinguish the individual dot colors,
but instead perceive a blended color produced by
groups of nearby dots.  By varying the colors and
placement of printer dots for each image cell (a pro-
cess called dithering), the printer can produce the
visual effect of the original colors in the image.

Low end printers use only
cyan, magenta, and yellow
inks.  Four-color (CMYK)
printers include a separate
black ink supply (K) to
produce pure black tones
and reduce the use of the
colored inks.  Some desktop
printers offer six or seven
inks, including lighter hues
of the primary ink colors.

Printer resolution is
measured in dots per inch,
abbreviated dpi.  Typical
desktop printers have print
resolutions of 300 to 720
dpi.  High-end desktop
printers and those used by
graphics service bureaus
may have resolutions of
1200 or 2400 dpi.



Getting Good Color

page 29

Printer Settings Window
To illustrate how color can be handled during print-
ing, we will work with a sample page layout designed
for printing to an 8.5" x 11" page in portrait orienta-
tion.  You can print layouts up to 11" x 17" in size
with TNTmips Free,  TNTmips Basic, TNTview, or
TNTedit.  The professional version of TNTmips sup-
ports printing to a variety of page sizes (as large as
current technology allows) and printing over mul-
tiple pages.

You make color adjustments for printing using the
Printer Settings window, which comes in two
versions.  When you choose Page Setup from the
Display menu, you can set up basic print parameters
and save them by pressing the OK button without
actually initiating printing.  When you select Print
from the Display menu, the Printer Settings window
opens with a Print button in place of OK, but the
remaining controls are identical.
Pressing the Print button starts
the printing process and closes
the window.

STEPS
choose Display / Open
from the Display
Manager and select
DEM_LAYOUT from the
COLOR Project File
choose Display / Print
from the Display
Manager

The layout used in these
exercises was created using
standard tools available in
the Page Layout
environment.  For an
introduction to the use of the
layout tools, consult the
tutorial booklet Making Map
Layouts.

You should already have a printer
set up from the Print exercise in the
tutorial Displaying Geospatial Data.
If not, use the controls on the Printer
tabbed panel to select one.

MicroImages recommends that you turn
on the Use Windows Printer radio
button (or Use Macintosh Printer on Mac
OS X) to use your operating system's
printer selection dialog to choose a local
or network printer and use its installed
print driver to control printing.
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STEPS
click the tab for the
Dithering panel and turn
on the toggle labeled Let
TNT do the dithering
press [Raster Dither
Pattern...]
from the list in the Dither
Pattern window that
opens, select Stucki
click [OK] to close the
Dither Pattern window
click [Print] on the
Printer Settings window
choose Display / Print
on the Dithering panel,
turn on the toggle Let
the Windows
[Macintosh] printer driver
do the dithering...
click [Print] on the
Printer Settings window

Dye sublimation printers and film
recorders are not limited to the
eight basic dot colors produced by
most printers.  They are able to
continuously vary the level of each
color component used to repro-
duce the image pixels, resulting in
true continuous-color output.
Dithering is not required when you
print to one of these devices, so
the dither pattern controls are
inactive.

Use the Dithering tabbed panel to set up dithering
options.  If you are printing to a Windows or
Macintosh printer using the installed print driver,
you have the choice of letting either the printer driver
or TNTmips control the dithering.  If you set the
printer driver to control dithering, use your system
printer setup dialog (opened from the Model button
on the Printer panel) to set the printing quality (which
controls how the print is dithered).  This method takes
best advantage of the printer's resolution and features
and will usually give you the most reliable results.

If you choose to let TNT control the dithering, you
can independently choose dither patterns for both
raster and nonraster components of your print layout.
The Floyd-Steinberg, Jarvis-Judice-Ninke, and
Stucki patterns usually provide good results for color
images on most printers, and the choice between
them is a matter of personal preference.  The sample
in the lower part of the Dither Pattern window gives
you some idea of how the pattern looks for different
colors.  The Stucki (enhanced gray) pattern  provides
the best results when you print a grayscale raster
image.  The default Vector pattern for nonraster
components insures continuity of thin lines in vector,
CAD, or TIN overlays, and those in map grids, scale
bars, and legends.

Choose Dithering Options
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Color Management Using Profiles
As you work with creating and printing layouts, you
may find that the colors in your prints do not match
very well with the display colors that you carefully
selected in designing your layout.  The source of
this problem is simple.  Computer displays and
printers use different color models and technologies
to produce colors, and they typically cannot produce
an identical range (gamut) of colors.

The solution to this problem is to use color profiles
that define how the color characteristics of a
computer display, printer, or other device translate
to a reference color space.  Profile files conforming
to the International Color Consortium's standard
format are referred to as either ICC or ICM files
and can have either file extension.  The TNT
products allow you to utilize color profiles for
displaying data in Views, for proofing to the screen,
and for printing.

ICC/ICM profiles may have been installed along
with the drivers for your display monitor and printer.
If not, they may be available for you to download.
In order for TNTmips to be able to use these profiles,
they must be in a specific location in your directory
structure (see the steps to the right for Windows).
On platforms other than Windows, the profile files
must be in your TNTmips directory.

The sRGB color space developed by Microsoft and
Hewlett-Packard has become the standard reference
color space for display monitors.  You can set
TNTmips to directly use a specific color profile to
display colors, or to pass sRGB color information
to the display driver to allow the driver and the
operating system to jointly handle the color
management.  This choice requires you to separately
set options for the operating system, the X-Server,
and for the Display process, as explained by the
Technical Guide entitled Color Management for X
Server and Views.

3D projections of sample
color gamuts from a monitor
(top) and printer (bottom).

To install a downloaded ICC/
ICM profile under
Windows:
copy the profile file to
the following directory:

c:\windows\system32\spool\
drivers\color\

right-click on the profile
file and choose Install
from the popup menu to
register the profile with
the operating system
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Proofing to the Screen
To ensure that your screen colors and print colors
match, you can use the Proof to Screen option on the
Profile tabbed panel of the Printer Settings window.
When this option is turned on (and other required
options are set properly, as outlined below), your
printer's ICM profile is used to adjust the layout colors
before they are rendered to your display to provide a
preview of how the colors should look when printed.

To sucessfully proof to the screen, you must properly
set the Options that govern how colors in general are

rendered to your computer
display.  These controls are
found on the Color panel of the
View Options window.  You
must choose Absolute
Colorimetric from the Rendering
Intent menu on the same panel.
(We will discuss rendering
intent further on the next page.)
You can proof to the screen

using either the default color profile for your monitor
(selected from the Profile menu), a custom profile that
incorporates your specific monitor settings, or using
sRGB and the display driver to handle color
management.

With the View Options set, you can then turn on the
Use ICM Profile toggle on the Profile tabbed panel of
Printer Settings window and select the ICM color
profile for your printer.  When you press [OK] on the
Printer Settings window, the layout will redraw with
the proof colors.

STEPS
choose Options / View
Options from the Display
Manager
click on the Color tab on
the View Options window
from the Rendering Intent
menu choose Absolute
Colorimetric
turn on the Profile radio
button
press [OK] on the
Options window

choose Display / Page
Setup from the Display
Manager
on the Profile panel of
the Printer Settings
window, turn on the Use
ICM Profile toggle
choose an ICM profile
from the Profile menu
turn on the Proof to
screen toggle button
press [OK] on the Printer
Settings window

NOTE: To ensure that the proof colors are printed
without modification, you also may have to turn off
your printer's color correction system.  If you are
using a system printer driver to control printing,
use the Model button on the Printer panel of the
Printer Settings window to access the system's
printer settings.  You may also have to turn on an
option to use ICM profiles in printing.
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Handling Out-of-Gamut Colors
STEPS

choose Display / Page
Setup from the Display
Manager
on the Profile panel of
the Printer Settings
window, turn on the
Use out-of-gamut alarm
toggle
press [OK] on the Printer
Settings window

Printers usually have significantly smaller color
gamuts than computer displays. This means that
there may be colors in your layout objects that
display properly on screen but are outside the range
of colors that your printer can produce.  When you
proof to the screen, you can turn on the Use out-of-
gamut alarm toggle to find out whether such colors
are present in your layout. The selected alarm color
(default red) is then used to flag the locations of the
out-of-gamut colors.

The Rendering Intent menu on the Profile panel of
the Printer Settings window lets you choose how to
translate out-of-gamut colors for printing.  Of the
rendering intents described below, Relative
Colorimetric Rendering and Perceptual Rendering
are most appropriate for translating the wide range
of your layout colors to your printer's narrower color
gamut.  (Note that for some proof settings the page
background may also be rendered in the alarm color.)

Absolute Colorimetric: source colors existing
within the destination gamut are unchanged; those
outside the destination gamut are replaced by the
nearest available color at the outer limit of the
destination gamut.  White may or may not be
reproduced exactly.

Relative Colorimetric: the brightness of all source
colors is rescaled so that the source white (RGB)
maps to the destination white (CMYK) and all other
colors are adjusted accordingly.

Perceptual: transforms the input color gamut so its
boundary maps on or close to the boundary of the
destination gamut.  This method compresses the
source gamut while preserving the relationships
between colors.

Saturation: modifies the source colors to fill the
destination gamut by allowing hue changes in order
to preserve the vividness of pure colors.

The darkest green colors
are out-of-gamut for the
printer profile shown on the
previous page.  You may get
different results with your
printer's ICM profile.

choose Display / Page
Setup from the Display
Manager
on the Profile panel of
the Printer Settings
window, turn off the Use
out-of-gamut alarm
toggle
examine the choices on
the Rendering Intent
menu
turn off the Use ICM
Profile toggle
press [OK] on the Printer
Settings window
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For routine printing tasks, you may not be concerned
with producing an exact match between screen and
print colors, but merely with producing a pleasing
set of print colors.  If that is the case, you can turn
off the Printer Settings option to use an ICM profile
for printing and experiment with the different color
correction options offered by your system printer
driver.

In addition, the Color panel of the Printer Settings
window provides a number of controls that allow
you to alter the manner in which image colors are
translated to the printer.  Using these controls you
can adjust the colors produced in the print without
altering the contrast tables, color palettes, and vector
colors you have created for the objects in your layout.

The colors produced by inkjet printers
are often darker and less saturated
than the corresponding screen colors.
The lower part of the Color panel
includes two horizontal sliders that
use the HIS color model to modify all
of the colors in the print image
simultaneously.  Moving the upper
slider to the right increases the
intensity (brightness) of all colors.
Moving the lower slider to the right
increases the saturation of each hue
at the expense of intervening pastel

shades.  The color sample bar above these sliders
changes as you move the sliders, giving you a
preview of their overall effects.  Many natural color
images benefit from modest increases in intensity
and saturation during the print process.  However, if
part of the image is already very bright, increasing
the overall intensity may “wash out” the color in this
part, resulting in a local loss of detail.

Adjusting Intensity and Saturation
STEPS

choose Display / Print
from the Display
Manager
click the Color tab on the
Printer Settings window
slide the Intensity slider
back and forth and note
the effect on the color
sample bar above it
repeat with the
Saturation slider
set the Intensity level to
20 and the Saturation
level to 15
press [Print] to print the
layout and close the
Printer Settings window

NOTE: The intensity and
saturation slider settings
are saved temporarily when
you print and when you
press [OK] on the
nonprinting Page Setup
window.  They can then be
saved along with any other
changes in the Layout
object if desired.

Intensity slider Saturation slider
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Color Balancing
The controls you adjusted in the previous exercise
influence all of the raster image colors in your print.
However, all screen colors may not print equally well
from a given layout.  For example, green and blue
typically print darker than other colors on inkjet print-
ers, and deep blue colors on the screen often appear
closer to purple when printed.  You can use the ver-
tical color sliders in the Color panel in conjunction
with the four icon buttons in the lower left part of
the panel to adjust individual output colors.

With the Brightness icon button turned on, moving
a slider increases or decreases the intensity of its
color.  With the Saturation button turned on, move a
slider up to increase the saturation (purity) of the
color, or move the slider down to move the color
toward gray.  The color bar beneath the sliders
previews the resulting effects.  Slider positions can
be saved by saving the layout object.  You can also
save these settings at any time in a color balance
object by pressing the Save button, and recall saved
settings using the Load button.

STEPS
choose Display / Print
from the Display
Manager
click the Color tab on the
Printer Settings window
with the Brightness icon
button selected (the
default) move the Green
slider upward to a value
of 10.6 and the Magenta
slider downward to a
value of -6.0
press the Saturation
icon button, and move
the Green slider upward
to a value of 10.6
press [Save], use the
File / Object Selection
window to navigate to
the COLOR Project File,
and name a new color
balance object
press [Print] to print the
layout and close the
Printer Settings window

My printer produces greens in the Mount
St. Helens DEM that are too dark and too
olive in tone.  The settings in this exercise
compensate by increasing the intensity of
green, decreasing the intensity of its
complement, magenta, and increasing the
green saturation.

Brightness

Hue ShiftHue

Saturation

The color sliders can also be
used in conjunction with the
Hue and Hue shift icon but-
tons to modify selected hues,
but this is a tricky procedure
that may produce unexpect-
ed results.  You should be
able to achieve a good color
balance using only the Bright-
ness and Saturation settings.
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Adjusting Gamma Contrast
The Gamma Contrast window provides an alterna-
tive means of selectively adjusting how object colors
are translated to print colors.  The relationship be-
tween the brightness variation of a source color and
the brightness variation of that color in a screen dis-
play or print is typically not a linear one.  Instead, it
is approximately a power function.  That is, the screen
or print brightness equals the source color bright-
ness raised to some exponent.  In computer graphics,
the Greek letter “gamma” is the symbol used for the
numerical exponent in the power function.

The Gamma Contrast window has for each color com-
ponent a Power text box in which you can enter a
value for the gamma exponent (the default is 1.00,
which defines a linear brightness translation).  The
Mode option button allows you to choose between
RGB (display color) or CMY (ink color) modes for
specifying gamma values.  Although color printing
uses CMY, it is easier to visualize the results using
RGB mode.  Entering a gamma value greater than
1.0 for red, green, or blue brightens the low to middle
intensity range of the color in the print; entering a
value less than one has the opposite effect.

STEPS
choose Display / Print
from the Display
Manager
click the Color tab on the
Printer Settings window
click [Gamma...]
in the Gamma Contrast
window, use the mouse
to highlight the Power
text box for Green, and
type in the value 1.4
change the Power value
for Blue to 1.2
click [OK] to accept the
values and close the
Gamma Contrast
window
press [Print] to print the
layout and close the
Printer Settings window
choose Display / Close
on the Display Manager
press [No] when you are
asked whether to save
changes to the layout

The Gamma Contrast window opens with
default values for gamma of 1.00 for each
color component.

Red-Green-Blue is the default color mode.

The gamma values used in this exercise
are designed to brighten the green colors
in the print without brightening red.  Green
areas should appear brighter in the print,
and brown areas should contain less red.

You can also change the allowed minimum
and maximum input and output values to
adjust the brightness and contrast of the
print.



Getting Good Color

page 37

Printing Test Strips
STEPS

reopen DEM_Layout and
select Print from the
Display menu
click the Color tab on the
PrinterSettings window
set the horizontal
Brightness slider to 20
and the Saturation slider
to 10
click [Test...]
in the Test Strip Setup
window, click [Add]
with the Brightness icon
button turned on, set the
color sliders to the
following values from left
to right:

 0.0, -4.4, -4.4, 0.0, 6.1, 3.0

click Add again
repeat the last two steps
with the following slider
settings:

 0.0, -6.0, -6.0, 0.0, 10.6, 6.1

click [OK] on the Test
Strip Setup window to
print the test strips

The settings on the Color panel affect the printing
process and not the screen display, so you must print
the layout to assess the results.  It may take some
trial and error to discover the best settings for your
printer, and printing the entire layout for each change
in settings would be time-consuming.  To avoid this
problem, you can print a set of test strips of a raster
layer that use a sample area to show the results of a
number of different color balance or gamma con-
trast settings.

If there is more than one
raster layer in your layout,
use the Layer option button
to choose which layer to
test.

Each test strip is preceded by a listing of all settings:

Color Balance Gamma Contrast:
RGB CMY

You can adjust settings for any or all of the color
balance parameters before adding a listing in the
Test Strip Setup window.  The listing shows the
settings for whichever parameter is currently
selected by a color balance icon button.
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Advanced Software for Geospatial Analysis
G
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MicroImages, Inc.
11th Floor - Sharp Tower
206 South 13th Street
Lincoln, Nebraska  68508-2010  USA

www.microimages.com

Index
additive primary colors.............................3,4
brightness, display...................................6-15
brightness, print..................................34-36
CMY color model.................................3,28
color balance....................................7,11,35
color conversion process........................27
color display mode..................................4,5
color palette (color map)...............17-22,24
color profile.................................31-33
color spread...................................21,22,24
composite color raster.........................16,17
contrast enhancement.....................6-13,27

auto-normalized.............................10,11
equalized...........................................13
exponential.........................................8
hyperbolic tangent.......................14
local area....................................12
linear...................................................7
logarithmic.......................................15
user drawn.................................15

dithering...........................................28,30
gamma contrast......................................36
gamut. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .31-33
HBS color model....................................21
HIS color model...........................21,26,34
hue..........................................................21,35
intensity...................................21,26,27,30,34
Printer Settings Window...................29-37
proof to screen.............................32-33
rendering intent............................32-33
RGB color model................................3,21
RGB raster display..........................5-15,27
RGBI raster display..................................26
saturation...........................................21,30,34
subtractive primary colors.............................3
test strips, printing..................................37
transparency

color palette......................................24
raster. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23
vector polygon fills............................25

MicroImages, Inc. publishes a complete line of professional software for advanced geospatial
data visualization, analysis, and publishing.  Contact us or visit our web site for detailed prod-
uct information.

TNTmips Pro TNTmips Pro is a professional system for fully integrated GIS, image
analysis, CAD, TIN, desktop cartography, and geospatial database management.

TNTmips Basic TNTmips Basic is a low-cost version of TNTmips for small projects.

TNTmips Free TNTmips Free is a free version of TNTmips for students and profession-
als with small projects.  You can download TNTmips Free from MicroImages’ web site.

TNTedit TNTedit provides interactive tools to create, georeference, and edit vector,
image, CAD, TIN, and relational database project materials in a wide variety of formats.

TNTview TNTview has the same powerful display features as TNTmips and is perfect for
those who do not need the technical processing and preparation features of TNTmips.

TNTatlas TNTatlas lets you publish and distribute your spatial project materials on CD or
DVD at low cost.  TNTatlas CDs/DVDs can be used on any popular computing platform.
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